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ABSTRACT 
 

The therapeutic potential of Pluronic F127 (PF127) hydrogel loaded with adipose-derived stromal 

vascular fraction (AdSVF), mesenchymal stem cells (AdMSC), and conditioned media (AdMSC-CM) 

for repairing full-thickness skin wounds was evaluated using a rabbit model. The rabbits were randomly 

divided into eight groups with six animals each and treatment was given as per the predetermined 

protocol (3 doses at one-week interval): Group A (Control), Group B (AdSVF), Group C (AdMSC), 

Group D (AdMSC-CM), Group E (PF127), Group F (AdSVF + PF127), Group G (AdMSC + PF127), 

and Group H (AdMSC-CM + PF127). Skin tissue samples were collected from the healing wounds on 

day 28 for staining and collagen quantification. Collagen density (Area %) was quantified using tissue 

sections stained with Masson's Trichrome (MT) and Picrosirius Red (PSR) stain using the Colour 

Deconvolution plugin of ImageJ and RGB stack method, respectively. These techniques function based on 
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1 Introduction  

Wound healing is a complex and dynamic process involving 

various cellular and molecular events to restore tissue integrity and 

functionality (Bist et al. 2021; Banu et al. 2023). Collagen, a major 

extracellular matrix (ECM) component, is pivotal in tissue repair, 

providing structural support and guiding cellular activities (Kular 

et al. 2014). In this study, PF127 hydrogel is loaded with adipose-

derived stromal vascular fraction (AdSVF), mesenchymal stem 

cells (AdMSC), and conditioned media (AdMSC-CM). These 

components are chosen for their regenerative potential and ability 

to influence the wound-healing microenvironment. Accurate and 

reproducible quantification of collagen density is imperative for 

evaluating the success of wound healing interventions. Masson's 

Trichrome (MT) and Picrosirius Red (PSR) staining methods are 

selected for their well-established roles in visualizing and 

quantifying collagen fibers in tissue sections (Marcos-Garcés et al. 

2017; Costa et al. 2019).  

MT staining is a widely used histological technique to visualize 

collagen fibers in tissue sections (Van De Vlekkert et al. 2020). This 

staining method is precious because it can differentiate collagen from 

other tissue components, providing enhanced contrast and detailed 

information about collagen morphology and distribution. The 

principle behind MT staining lies in the differential affinity of tissue 

components for specific dyes (Chang and Kessler 2008). MT 

staining finds its applications in various realms of research and 

diagnostics. Researchers often rely on its ability to assess collagen 

density, with the intensity of the blue or green colouration acting as a 

quantitative indicator. Beyond quantification, the method detects 

fibrotic changes, making it a go-to tool for identifying pathological 

conditions like cardiac fibrosis, liver cirrhosis, and pulmonary 

fibrosis (Chang and Kessler 2008; Van De Vlekkert et al. 2020).  

PSR staining is a widely used histological technique that provides 

excellent visualization of collagen fibers within tissue sections 

(Lattouf et al. 2014; López De Padilla et al. 2021). While its true 

power is often showcased under polarized light, PSR staining is 

also valuable when observed under regular brightfield microscopy 

(López De Padilla et al. 2021). This technique enhances the 

contrast between collagen and surrounding tissues, offering 

detailed insights into collagen distribution, density, and 

morphology (Lattouf et al. 2014). The principle of PSR staining 

involves the interaction between the dye and collagen fibers. 

Picrosirius Red, derived from the synthetic dye Sirius Red F3BA, 

has a specific affinity for collagen (Sharma et al. 2015). When 

applied to tissue sections, PSR binds to collagen molecules, 

resulting in distinct colouration under brightfield microscopy 

(Lattouf et al. 2014; López De Padilla et al. 2021). Both methods 

offer distinct advantages, and their comparative evaluation in this 

study aims to elucidate their efficacy in the specific context of 

digital collagen quantification.  

In wound healing research, accurately quantifying collagen density 

is essential for assessing the efficacy of therapeutic interventions. 

This study evaluates two widely used staining methods, MT and 

Picrosirius Red, for digitally quantifying collagen density in a 

rabbit model of full-thickness skin wounds. The rationale behind 

this investigation lies in the need for robust and reliable techniques 

to measure collagen levels precisely, aiding in the comprehensive 

understanding of wound healing responses to various treatments.  

Understanding the comparative performance of these staining 

methods is critical for researchers and clinicians involved in 

wound healing studies. Reliable collagen quantification contributes 

to optimizing therapeutic strategies and enhances the translatability 

of preclinical findings to clinical applications (Marcos-Garcés et 

al. 2017). We hypothesize that both MT and PSR staining methods 

will effectively quantify collagen density in healing wounds but 

may yield subtle differences in absolute values due to their distinct 

mechanisms of action. The results of this comparative evaluation 

will guide researchers in selecting the most suitable staining 

method for their specific wound-healing research contexts. 

2 Materials and Methods 

2.1 Masson's Trichrome staining 

The MT staining procedure was performed on paraffin-embedded 

tissue sections. These sections were initially dewaxed by 

separating different colour channels in the stained tissue sections to isolate the collagen fibers 

and then quantifying them through thresholding and image analysis. Across the treatment groups, 

both staining methods generally showed a trend of increased collagen density compared to the 

control group. For most groups, PSR staining consistently indicated slightly lower collagen 

densities than MT staining. However, the overall trends were similar in both staining. The 

comparison between PSR and MT staining methods revealed that both techniques effectively 

assess collagen density in healing wounds. However, there were subtle differences in the 

absolute values obtained, with PSR staining tending to yield slightly lower collagen density 

measurements than MT. These differences can be attributed to the distinct mechanisms of these 

staining methods. Therefore, both staining methods can digitally quantify collagen density in 

wound healing research. 
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immersion in xylene until the paraffin was removed entirely. 

Subsequently, a series of descending alcohol concentrations 

(100%, 90%, 70% and 50% alcohol) were used for rehydration, 

followed by a rinse in distilled water. The nuclei of the tissue 

sections were stained with Weigert's iron haematoxylin for 

approximately 5-10 minutes, and the excess stain was removed by 

rinsing with tap water. Cytoplasm and muscle fibers were stained 

using Biebrich scarlet-acid fuchsin solution for 15-30 minutes, 

followed by another rinse in distilled water. The sections were 

treated with a phosphomolybdic-phosphotungstic acid solution to 

differentiate collagen and muscle fibres for 15 minutes. Collagen 

fibers were stained blue by immersing the sections in an aniline 

blue solution for 5-10 minutes, followed by a brief rinse in distilled 

water. After acid differentiation with 1% acetic acid solution, 

sections underwent gradual dehydration through ascending alcohol 

concentrations (70%, 80%, 90%, and 100% alcohol) and were 

cleared in xylene. Finally, a mounting medium (DPX) was applied 

to each section, covered with a glass coverslip, and allowed to dry. 

The stained tissue sections were then examined under a light 

microscope with appropriate filters for MT staining, facilitating the 

distinction of collagen fibers (blue) in histological analysis. 

2.2 Collagen quantification using the Colour Deconvolution 

plugin in ImageJ software 

Collagen density (Area %) was quantified using tissue sections 

stained using MT stain based on the protocol described by Chen et 

al. (2017) with modifications. The principle behind quantifying 

collagen in skin stained with MT stain using the Colour 

Deconvolution plugin in ImageJ is based on the separation of 

different colour channels in the stained tissue sections to isolate the 

collagen fibers and then quantifying them through thresholding and 

image analysis (Ruifrok and Johnston 2001; Landini et al. 2021). 

The first step involves installing the ImageJ software on a 

computer. To achieve this, the user downloads and installs the 

software opens it, and loads the digital image of the MT-stained 

skin section by navigating through "File" > "Open" and selecting 

the image file. Moving on to the second step, the user is provided 

with two methods for installing and setting up the colour 

deconvolution plugin. In Method 1, the Color Deconvolution 

plugin is downloaded from the ImageJ website, saved in the 

"plugins" folder within the ImageJ directory, and ImageJ is 

restarted to ensure plugin recognition. In Method 2, the user is 

guided to download the JAR file from a specified link, and in 

ImageJ, the plugin is installed by going to the "Plugins" menu, 

selecting "Install...," and following the prompts. The user may 

need to restart ImageJ to complete the installation.  

Select the "Straight Line" tool from the ImageJ toolbar. This tool 

allows us to measure the length of the scale bar (Figure 1). By 

clicking at one end of the scale bar in the image and without 

releasing the mouse button, drag the line to the other end of the 

scale bar. Release the mouse button to draw a straight line along 

 
Figure 1 Steps for performing collagen quantification in ImageJ. The scale has to be calibrated to ensure accurate measurements.  

Use the straight-line selection tool to draw a line along the scale bar and set the known measurement. The input images should  

be converted to RGB images before performing the analysis 
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the scale bar. In the ImageJ main menu, go to "Analyse." Select 

"Set Scale." This will open the "Set Scale" dialog box. In the "Set 

Scale" dialog box, Enter the known distance of the scale bar (in 

micrometres) in the "Known Distance" box. Set the unit of length 

(e.g., μm) in the "Unit of Length" box. Click "OK" to set the scale. 

Open the image to analyze. The input images were converted to 

RGB images by clicking on the "Image" menu (Figure 1), clicking 

on the "Type" box, and then "RGB Color." Click on "Image" > 

"Color" in the menu bar and select "Colour Deconvolution2." In 

the Colour Deconvolution dialog box, the Masson's Trichrome 

stain vector should be chosen (Figure 2) (Ruifrok and Johnston 

2001; Landini et al. 2021).  

Parameters were set as indicated in Figure 3. This was followed by 

clicking "OK" to perform the colour deconvolution. This will 

create separate grayscale images corresponding to each stain (red, 

blue and green components) and select the grayscale image 

corresponding to the collagen stain (blue). Click on "Image" > 

"Adjust" > "Threshold" to open the Threshold dialog box (Figure 

3). Adjust the threshold settings to segment the collagen fibers 

accurately. The settings mentioned above are appropriate to 

achieve the best results. Click "Apply" to apply the threshold to the 

image, making the collagen fibers appear as a black and white 

binary image. In the ImageJ main menu, click on "Analyze." From 

the dropdown menu, select "Set Measurements." This will open the 

"Set Measurements" dialog box. In the dialog box, make sure the 

following options are checked: "Area" to measure the area of 

selected regions, "Standard Deviation" to calculate the standard 

deviation of pixel values within the selected regions (Ruifrok and 

Johnston 2001; Landini et al. 2021), "Area Fraction" to determine 

the fraction of the total area covered by the selected regions, 

"Display Label": to display labels or names for the measured 

regions, and "Limit to Threshold" to limit measurements to areas 

within the threshold (Figure 4). 

 
Figure 2 Steps for performing collagen quantification using image deconvolution technique in ImageJ. Choose the Masson's  

Trichrome stain vector in the Colour Deconvolution dialogue box. This will create separate grayscale images corresponding  

to each stain (red, blue and green components) 
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Figure 3 Steps for performing image thresholding in ImageJ. The grayscale image corresponding to the collagen stain (blue)  

will be selected. The threshold settings should be adjusted to segment the collagen fibers accurately 

 

 
Figure 4 Steps for performing collagen quantification in ImageJ. Once the threshold is applied, the collagen fibers appear as a black and 

white binary image. Once the measurement parameters are set, ImageJ will calculate and measure the area, standard deviation, and area 

fraction of the regions of interest (ROIs) within the threshold 
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Go back to the ImageJ main menu and select "Analyze." From the 

dropdown menu, choose "Measure" (or "Ctrl + M" can be pressed 

on the keyboard). ImageJ will calculate and measure the area, 

standard deviation, and area fraction of the regions of interest 

(ROIs) within the threshold. The measurement results will be 

displayed in the "Results" window. To further analyze or quantify 

the ROIs, they can be manually selected and extracted by using 

tools such as the "ROI Manager" in ImageJ ("Analyze" > "Tools" 

> "ROI Manager"). Once the ROIs are selected, area-based 

analysis can be performed. The results table will show 

measurements of the collagen area in the selected image. To 

quantify collagen in multiple images, the steps for each image can 

be repeated (Ruifrok and Johnston, 2001; Landini et al. 2021). 

Export or save the measurement results for further analysis if 

needed. Import the measurement results into a spreadsheet 

program for data analysis and visualization. 

2.3 Picrosirius red staining for collagen estimation 

PSR stain (Solution A) was prepared by mixing 0.5 g of Direct 

Red 80/Sirius red F3B (Sigma-Aldrich, Catalog # 365548) in 500 

ml of saturated aqueous solution of picric acid. This solution was 

considered stable and can be stored for at least 3 years and used 

multiple times. Solution B is acidified water made by mixing 5 ml 

of glacial acetic acid in 1 litre of distilled water. The tissue sections 

were deparaffinized by incubating them in xylene (two changes) 

and then rehydrated by passing them through a graded ethanol 

series (100%, 90%, 70%, 50% and distilled water). The nuclei 

were stained using Weigert's iron haematoxylin (8 min) and the 

slides for 10 minutes in running tap water. The sections were 

stained in PSR (Solution A) for one hour. It has to be noted that 

longer staining time with PSR did not improve the staining quality, 

but shorter staining times were discouraged, even if the colours 

appeared satisfactory.  

After staining, the sections were washed in two changes of 

acidified water (Solution B). Most of the water was removed from 

the slides either by vigorous shaking or, in the case of a few slides, 

by blotting with damp filter paper. The sections were then 

dehydrated in three changes of 100% ethanol. Finally, the sections 

were cleared in xylene and mounted using a mounting medium and 

coverslip. Once the slides were prepared, the collagen fibers were 

visualized using a light microscope.  

2.4 Collagen quantification in picrosirius stained sections 

Open the image of the picrosirius stained tissue section in ImageJ. 

Measure the scale bar in the image using the straight-line selection 

tool. Create a line selection along the length of the scale bar. Go to 

"Analyze" in the menu bar and select "Set Scale." In the "Set 

Scale" dialog box, Ensure that the "Distance in Pixels" field is 

automatically populated with the length of the line selection. Enter 

the known distance (in µm) in the "Known Distance" field. Set the 

"Unit of Length" to "µm" (micrometres). Click "OK" to apply the 

scale to the image. In the menu bar, go to "Image" and select 

"Type," then choose "RGB Stack" to split the image into its red, 

green, and blue channels (Figure 5). After splitting, go to "Image" 

and select "Stacks," then choose "Make Montage" to view all three 

 
Figure 5 Steps for performing collagen quantification using RGB stacking technique in ImageJ 
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channels simultaneously (Figure 6) (Ruifrok and Johnston 2001; 

Landini et al. 2021). Select the RGB stack, making sure the green 

channel is chosen. While the Green channel is selected, go to 

"Image," then select "Adjust" and choose "Threshold." The 

"Threshold" tool will open, and the green channel will be 

thresholded automatically.  

However, the threshold for accurate collagen detection was 

manually adjusted. Move the lower slider to the right until the 

red-stained collagen is highlighted in red while the background is 

mostly black. Once the threshold is set correctly, click "Apply" 

in the "Threshold" tool. Open the "Analyze" menu and select 

"Set Measurements." In the "Set Measurements" dialog box, 

check the following options: "Area," "Area Fraction," "Limit to 

Threshold," and "Display Label." Close the "Set Measurements" 

dialog. To measure the thresholded collagen area, go to 

"Analyze" and choose "Measure." The area and percent area of 

the thresholded collagen will be displayed in the "Results" 

window (Figure 7) (Ruifrok and Johnston 2001; Landini et al. 

2021). 

 
Figure 6 Steps for performing collagen quantification using RGB stacking technique in ImageJ. This will split the image into  

its red, green, and blue channels. A montage was done to view all three channels simultaneously 
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3 Results 

3.1 Masson's Trichrome versus Picrosirius Red Staining 

In MT staining, collagen fibers are stained blue. By staining 

collagen blue, this technique allows for the visualization and 

assessment of collagen distribution and content in tissue samples 

(Figure 8). Blue-stained collagen fibers are often seen as tissues' 

structural framework or scaffold. Muscle fibers, cytoplasm, and 

keratinized structures (such as keratinized skin cells) are stained 

red or pink in MT staining. This staining is achieved using 

Biebrich scarlet-acid fuchsin solution. The dark black colouration 

of the nuclei results from the staining with Weigert's iron 

haematoxylin. 

In PSR staining, collagen appeared red against a pale-yellow 

background under brightfield microscopy (Figure 8). The nuclei 

ideally appeared black, although they might often appear grey or 

brown due to the extended exposure to picrosirius red, which 

caused some degree of de-staining of the nuclei. 

 
Figure 7 Steps for performing collagen quantification using RGB stacking technique in ImageJ.  

The threshold settings should be adjusted to segment the collagen fibers accurately 
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3.2 Comparison of collagen density in Masson's Trichrome and 

Picrosirius Red stained sections 

We compared the collagen density values obtained using two 

different staining methods, PSR and MT (Figure 9). This 

provides insights into how these techniques measure collagen 

content and organization in the healing wounds of the studied 

groups. The baseline collagen density in healthy skin, measured 

with PSR staining, was 75.15±1.78%. MT staining, on the other 

hand, indicated a slightly higher baseline collagen density of 

82.08±4.95%. Across the treatment groups, both staining 

methods generally showed a trend of increased collagen density 

 
Figure 8 Photomicrographs of healthy rabbit skin from dorsum showing normal histological structures (Top panels - x100 and Lower panels 

- x200). The stained section of normal rabbit skin shows a well-organized structure with intact epithelium, hair follicles, and a loose  

            connective tissue dermis. Note: keratin layer (black arrow), epidermis (E), collagen fibers (C), hair follicles (black arrowhead) 

 

 
Figure 9 Comparative analysis of collagen density (Area %) values generated from MT and PSR stained sections using colour  

deconvolution and RGB stack methods. Note: ** - p < 0.01and **** - p < 0.0001 
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compared to the control group. For most groups, PSR staining 

consistently indicated slightly lower collagen densities than MT 

staining. However, the overall trends were similar.  

The comparison between PSR and MT staining methods revealed 

that both techniques are effective in assessing collagen density in 

healing wounds. However, there were subtle differences in the 

absolute values obtained, with PSR tending to yield slightly lower 

collagen density measurements than MT. These differences can be 

attributed to the distinct mechanisms of these staining methods. 

PSR specifically stains collagen fibers and provides an enhanced 

visualization of collagen organization, making it suitable for 

assessing collagen fiber quality and maturity.  

4 Discussion 

The histological assessment conducted by trained pathologists 

utilizing semi-quantitative scoring techniques has traditionally 

been employed for evaluating collagen fiber density. 

Nevertheless, the subjective nature of this histologic evaluation 

is susceptible to inter-observer bias, leading to diminished 

accuracy and reproducibility due to inherent methodological 

constraints (Lee et al. 2001). Previous studies have focused on 

assessing collagen fibers by categorizing them based on the 

different scoring systems. Regrettably, this system was limited to 

demonstrating qualitative improvements and couldn't provide 

quantitative data (Meyer et al. 2017). In contrast, the 

methodology used in this study facilitates the direct comparison 

of collagen fiber density using continuous values and rigorous 

statistical analysis, allowing for a quantitative assessment of the 

therapeutic effects. MT stain is a histological staining method 

that uses multiple dyes to distinguish various tissue components. 

The stain typically consists of Weigert's Haematoxylin (stains 

nuclei dark purple or black), Aniline blue (stains collagen fibers 

blue), and Biebrich scarlet-acid fuchsin (stains cytoplasm other 

cellular components red).  

MT techniques effectively provide intense staining for collagen 

fibers in connective tissue. This technique is best for collagen 

fibres' quantitative visualization and analysis capabilities. 

However, they fall short in selectively staining specific structures, 

such as the basal membrane (Constantine and Mowry 1968). This 

lack of selectivity poses challenges in accurately differentiating 

structures, especially in the presence of thin collagen fibers that 

may exhibit different colours within the same tissue section. MT 

staining is hindered by a background stained red by the dye, 

complicating the distinction between true colours observed (Street 

et al. 2014). 

PSR staining is a more straightforward and highly effective 

method for examining collagen arrangement. This technique offers 

results superior to routine staining techniques (Juengsomjit et al. 

2022). This technique involves Sirius red reacting with basic 

groups in collagen molecules through its sulfonic acid groups, 

thereby effectively staining the collagens (Junqueira et al. 1979). 

Unlike trichrome staining, PSR staining has been widely regarded 

as the benchmark for detecting and quantitatively estimating 

collagen in histological sections of both normal and abnormal 

tissues (Segnani et al. 2015). 

A study evaluated a porcine model for pathomorphological age 

assessment of surgically excised skin wounds. The results were 

assessed through special staining techniques involving MT and 

picrosirius red. MT and PSR stains confirmed newly formed 

collagen and effectively evaluated increased collagen deposition 

(Barington et al. 2018). Both these stainings have addable 

advantages in predicting the variation in levels of myofibroblast 

and collagen in wound healing (Owens et al. 2010).  

The principle begins with colour deconvolution, which separates 

these individual stains into distinct grayscale channels. The 

Colour Deconvolution plugin in ImageJ takes advantage of the 

fact that each stain has a characteristic colour spectrum (Ruifrok 

and Johnston 2001; Landini et al. 2021). Using mathematical 

algorithms, the plugin separates the RGB (Red-Green-Blue) 

colour channels of the stained image into grayscale images 

corresponding to each stain. In this case, the blue collagen stain 

is isolated. After separating the collagen stain into a grayscale 

image, the next step involves setting a suitable threshold (Chen 

et al. 2017). Thresholding converts the grayscale image into a 

binary image, where the collagen fibers appear black against a 

white background. This is achieved by specifying intensity 

values above which pixels are considered part of the collagen 

(black) and below which they are not (white) (Chen et al. 2017). 

The choice of thresholding values depends on the image's 

staining intensity and background noise. After measuring the 

collagen area in one or more images, analysis was done to derive 

quantitative information (total collagen area) (Chen et al. 2017; 

Elshazly et al. 2023). 

Conclusion 

Picrosirius Red staining consistently indicated slightly lower 

collagen densities than Masson's Trichrome staining. However, the 

overall trends were similar in both staining. The comparison 

between Picrosirius Red and Masson's Trichrome staining methods 

revealed that both techniques effectively assess collagen density in 

healing wounds. However, there were subtle differences in the 

absolute values obtained, with Picrosirius Red staining tending to 

yield slightly lower collagen density measurements than Masson's 

Trichrome. These differences can be attributed to the distinct 

mechanisms of these staining methods. Therefore, based on our 

findings, both staining methods can digitally quantify collagen 

density in wound healing research. 
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